TURN YOUR FAMILY FOLDERS INTO FAMILY HISTORIES

Terry Manning (temanning@aol.com)
Getting Started

Getting started is as simple as having a computer with any basic word processing program such as WORD and deciding how you want to organize your chapters and to lay out your history of each ancestor.  You should also have a reference on how to write footnotes.  Elizabeth Shown Mills’ book, Evidence! Citation & Analysis for the Family Historian (Baltimore: Genealogical Publishing Company, 1997 – Hardbound, 124 pages, $19.95) is one such source (also her QuickSheet Citing Online Historical Resources – Evidence! Style* - $8.95).  Most English writing books will also cover this subject but their references will not be genealogy research specific.

Organize Your Chapters.  Create one set of records for your maternal line and one set for your paternal line (or better yet, four sets of records – one for each grandparent’s line).  Create a chapter for each direct-line ancestor.  If you include yourself as Chapter 1 in your paternal line of records, your father is Chapter 2, his parents are chapters 3 and 4, and their parents are Chapters 5 to 8.  Chapters 65 to 128 are one’s fifth great-grandparents and notes about their ancestors.  Including the fifth and later generations in one chapter works well because later generations tend to have little or no information about them to warrant a narrative style.  Create a Table of Contents showing these chapter assignments.  (See the handout for an example).  Notice that some of the chapters remain blank and are not included yet, but it is important to leave the numbers for those chapters reserved for those ancestors.  Now you will follow the Table of Contents in writing your family history.

Chapter Layout.  Next you must decide how to lay out each chapter.  You need to decide the font style that you want to use, the size of your print, your margins, how headings will look, format for any headers or footers, and the subject sections that you want to include, including how to handle any attachments.  (See the handout for a typical format.)  A good format is to cover the major aspects of a person’s life as sections of each chapter, such as:

· Birth and Early Youth
· Surname Variations [if helpful]
· Marriage(s)

· Military Service [excluded for females]

· Children and Other Residences [not repeated for the female if the same]

· Occupation, Education, and Other Notes

· Death and Burial

For those who like to follow descendant and collateral lines include an Attachment A of the grandchildren and other descendants of a person if you have that information.  These tend to be more in line with “Ralph and Nancy begat George” listings.  If especially lengthy, make them a separate record and only refer to that record.
Including a transcription of each direct line ancestor’s federal population census records covered by their lifetime at the end of their chapter can be very helpful.  You may want to add photographs, maps, or copies of significant records to your chapters.

Once you decide on a format you can copy that format to other chapters to save time and typing.

Writing Philosophy.  Consider the following guidelines:

1. Provide a footer showing the date this chapter was last revised.  This makes it easy to substitute more current versions among copies left at libraries and other researchers.  To save printing out each version you may keep the most current version on your computer but not print out a copy for your working notebook if it only includes a minor change.  A handwritten note such as “Copy of 1850 census obtained” may suffice in your working copy.  
2. Footnote each statement of fact with the most reliable source of information used to report the data.  More than one footnote may be desired or needed to cover all of the information. Use standard footnote format such as those shown in Handout A.  Endnotes may be used in place of footnotes, but this generally requires more printing to make corrections and additions to your chapters.  Footnoted sources make your work more convincing and allow yourself and others to judge the value of the source and to make informed decisions about doing further research.  While visiting a genealogy library and finding a book of transcribed birth records you would know for example to copy that source in place of the e-mail from your second cousin which initially provided you that data without another reference.  Similarly, later obtaining the record from a courthouse allows you to replace the reference to a transcribed version or gives you the option of spending time to get the courthouse record in light of how trustworthy you think the secondary source might be.  At any rate, it can be extremely valuable to have with you the information on where your source came from as you’re doing field research.

3. Start the numbering of footnotes with 1 on each page to avoid excessive printing of entire chapters when only 1 page needs correction (i.e, inserting a new footnote on page 1 will change the numbering of all the following footnotes in the chapter unless you specifically set your computer to re-start the numbering on each page).

4. Use a common format for placement of footnote numbers in the text.  A footnote number at the end of a sentence and included inside the period should cover all of the data within the sentence or since the last footnote within the sentence.  A footnote number at the end of a sentence and outside the period should cover all of the data subsequent to the last footnote used, which may include several sentences or an entire paragraph.  Provide a footnote no less often than for each paragraph.

5. Do not use an abbreviated form of a footnote because the original footnote may be deleted at a later date.  With the ease of computers just copy any long footnotes.

6. Make reference to which chapters include detailed information on the subject’s parents and children.  This precludes your providing repetitive detail (including footnotes on source data) about parents and children.

7. Provide separate chapters for the wives because they very often outlived the husband and remarried and have their own stories to tell.  In doing this you avoid repeating information from the sections called Marriage and Children and Other Residences in the wife’s history.  Simply make reference to the chapter on her husband if the data will be the same.

8. Don’t refer to the name of a county or state using its present day name if an event took place there under another name.  Use the name in use at the time and explain that the area is now called by another name.  This makes it clear to everyone using the data what you mean.  This is very important regarding county names when pointing other researchers to source data.
9. Boldface whole names to make them stand out in your text.

10. If you are making an assumption or have a guess as to some event or information about a person make sure that you clearly explain it as such.  Explain your reasoning and allow others to continue the search accordingly based on all the information you know to date.  Don’t make them start over.  If a source of information was sought and not found as expected, explain that also.  An obituary may state that someone was married in a certain county and state, but if you check the courthouse records and there is no record of such an event you should provide that information to prevent others from repeating the search or to alert them that the record may be difficult to find.  Providing information on the newspapers you researched for obituaries and death notices is especially helpful to others.

11. Use the full maiden name with the married surname given as the chapter heading for females.  This provides the most information to prevent confusion.

12. Number the pages in each chapter starting with page 1.

13. Avoid using pronouns unless it’s absolutely clear to whom you’re referring.

14. If you have a number of persons of the same name in your text, clarify them with a note such as their birth date in parenthesis, or a reference to them such as I, II, III, Junior, the “elder”, etc. – “Tom Smith (1756) and Tom Smith (1774) both owned land in Lumpkin County, Kentucky, in 1824.”
Tips for Creating a Chapter

Limit the number of chapters you keep in a computer file.  You can create separate files for each chapter but that becomes cumbersome.  Consider keeping the Table of Contents, Introduction, and first 8 chapters in one file, and each succeeding generation in a separate file.  Keep backup CDs or flashdrives of everything!!!

Census data can be recorded as part of a chapter file or in separate files.

Within a file it is easiest to separate chapters with section breaks.  This method allows you to create separate footnotes for each chapter and makes it easy to print one chapter at a time by printing only the section that the chapter is in on that file.

Using a narrative style allows more variety in your history.  You can include interesting information such as things taking place in history at that time, transcripts of obituaries and tombstones, and descriptions of the lifestyle of people of the period.  Most importantly it allows you to discuss weaknesses and strengths in your research and to alert others to possible future research opportunities to continue the family line.

Computer Tips
Inserting a Footer – A footer is information inserted at the bottom of a page and generally repeated on consecutive pages within a section or chapter, such as page numbers, the chapter number, the publication or revision date, or other such information desired on every page. A footer is therefore different from a footnote.

Within a section or chapter you create a footer by placing your cursor somewhere on the first page and selecting the View menu and clicking on the Header and Footer option.  In WORD your cursor will then be moved to the top of the page in the top margin where you may insert a header.  [The process is the same for a header and footer, therefore we will only cover inserting a footer. Your handout only uses a footer.]  A Header and Footer selection box will also appear.

To move to the footer, click on the third icon from the right (a white square with a yellow rectangle above it (header) and a yellow rectangle below it (footer)) in the Header and Footer selection box.  This moves the cursor to the margin at the bottom of the page (the rectangular area surrounded by dashed lines) where the footer will be placed.  The rectangular box will be marked “Footer” in the upper left corner.  Now you type in the information that you want and choose the Close button.  The footer that you typed will be included on every page of the chapter.  [Note that if you have created another chapter prior to this one that you have the option of using the same footer.  The next icon to the left of the icon you used to move to the footer is an on/off button for making the footer the same as the previous footer or different.  You should click the button off so that your footers are not the same. The “Same As Previous” note at the top of the dashed rectangle will disappear when you turn the option off.]

Remember that if you include a page number in your footer you should choose the option for starting over again at number 1 on the first page of the section or chapter.  A little practice at this will make you a computer pro!

Inserting a Footnote – For those using WORD you can insert a footnote by placing your cursor at the point in your text where you want the footnote reference number to appear and then by clicking on the Insert menu and then choosing Footnote.  The Footnote and AutoNumber options should be already highlighted in the box that appears, so click on the Options button.  Then select Restart each section.  Click OK.  Click OK.

The computer will insert a number at the point where your cursor was and then take you automatically to the bottom of the page and place the cursor where you type the information for your footnote entry.  When you have finished the footnote entry, move your cursor back to the main text where you want to continue more typing (or press the Page Up key on your keyboard).

After inserting the first footnote you will only need to click on the Insert menu and then choose Footnote and OK to insert additional footnotes in the same file.

To delete a footnote, highlight it and punch the Delete key (or place your cursor in front of it and hit the delete key twice).  To copy a footnote elsewhere, highlight the footnote number, click the copy icon (or use the Edit and Copy options), place your cursor where you want the footnote copied, and click the print icon (or choose Edit and Copy options). 

Inserting a Section Break – To start a new chapter with its own formatting, footer, etc. place your cursor at the end of the chapter preceding where the new chapter will be located.  Select the Insert menu and Break option.  Under Section breaks choose Next page and click OK.  Your cursor will now be at the top of the next page ready to start a new chapter.  Each section break will be numbered consecutively and represent its own chapter.  To print a single section look at the bottom of the screen for the “Sec 1”, “Sec 2”, etc. designator, and when you make your print options type s1, s2, etc. under the Page range’s Page section of the print options box. [To print section 14 corresponding to your chapter 14, enter s14 as your page selection in the print options box.]

Once you have a section break to begin a new chapter you can save typing and formatting time by copying a sample set of headings from a previous chapter into the new section and making typing corrections to the data for the new chapter.  While your cursor is anywhere in the new chapter you can go the footer [as previously described] and revise it as needed.
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